Outline of Coverage and Frequency Research Methodology ..................................................... 3
Travel Surveys.......................................................................................................................... 4
Traffic Flows........................................................................................................................... 4
Visibility adjusted contacts (OTS).......................................................................................... 5
Poster Classification .............................................................................................................. 9
Roadside, Retail and Travel environments.............................................................................. 9
Poster and Cafas terminology ............................................................................................... 11
Coverage or Reach ............................................................................................................... 11
Frequency .............................................................................................................................. 11
N plus (N+) coverage .......................................................................................................... 11
Flow..................................................................................................................................... 11
OTS...................................................................................................................................... 12
VAC ..................................................................................................................................... 13
VAC coverage......................................................................................................................... 14
Population covered............................................................................................................... 14
Visibility adjusted contacts................................................................................................. 14
Visibility adjusted average frequency.................................................................................. 15
Cost per thousand ................................................................................................................ 15
GRP...................................................................................................................................... 15
Share of voice........................................................................................................................ 16
Illumination............................................................................................................................ 16
Distribution ............................................................................................................................ 17
Coverage model areas.......................................................................................................... 18
Poster orientation.................................................................................................................. 20
Poster orientation.................................................................................................................. 21
Program usage and screen content. ....................................................................................... 22
Digest or Summary of stock................................................................................................. 24
Sheetage by media owner: ................................................................................................. 24
Sheetage by kommun/district: ............................................................................................. 25
Flow by media owner: .......................................................................................................... 26
Traffic in daylight.................................................................................................................. 27
OTS by media owner: .......................................................................................................... 28
VAC by media owner: .......................................................................................................... 29
Network or Campaign Analysis ............................................................................................ 30
Network or Campaign file selection...................................................................................... 31
Campaign sheetage.............................................................................................................. 32
Details of Tab analysis contents: .......................................................................................... 32
Network/Campaign analysis – Roadside: ............................................................................. 33
Network/Campaign analysis – Travel: ................................................................................ 34
Network/Campaign analysis – Retail: ................................................................................ 35
Network/Campaign analysis – Transport (Buses or Trams):................................................. 36
Panels without scores ........................................................................................................... 36
Network/Campaign analysis – Combined: .......................................................................... 37
Campaign Charts – Cover over time / N Plus................................................................. 38
Copying the Chart: .............................................................................................................. 42
Copying the data behind the chart: .................................................................................... 43
Analysis Campaign Comparison ......................................................................................... 45
The Campaign Save screen in Pictures............................................................................... 45
The Campaign comparison screen..................................................................................... 47
Cost Per Thousand .............................................................................................................. 50
Campaign Planner.............................................................................................................. 53
Campaign planner – Further Notes.................................................................................... 53
Outline of Coverage and Frequency Research Methodology

Measuring the coverage or reach and frequency of poster campaigns is much more complex than comparable media such as TV, radio or press, which are active mediums where an opportunity-to-see (OTS) or hear or read is dictated by the viewer or reader actively choosing to participate in the medium. (The equivalent outdoor term is OTS opportunity-to-contact).

The first point of difference with traditional media is that the “outdoor or out-of-home” medium is regarded as a passive medium, that is, the viewers are not actively seeking to look at the posters. In this way an out-of-home OTS in not necessarily converted into a contact in the same way as other mediums. Noting that these other mediums, Television, Radio and Press also have problems guaranteeing an OTS is a contact, or in its measurement.

Because of this passive nature of the medium, two separate research programs need to be undertaken and then married together so that we can calculate who is reached or covered by a campaign of posters.

The first program is a travel survey, since we cannot simply stop people as they pass a poster and interview them, we must conduct very large-scale market research surveys to determine the journeys and routes of a representative sample of the population. Because we are not just asking a simple yes/no question, but tracking our respondents over time, the reliability of the survey is based on the total number of passages past posters made, not just on the total number of respondents. The survey in Norway recorded 178,000 passages past roadside sites over the survey period, with a sample of 3,047 respondents.

The second program is a classification and traffic allocation system for every poster included in the research system. This classification and traffic allocation system produce three, gradually more refined, basic measures for each poster site, Traffic Flow, Opportunity-to-See/Contact, Visibility adjusted contact. (Flow/OTS/VAC)

By the integration of the travel survey data, who goes where and when, and the poster classification survey, where each poster is located, complex mathematical models were developed that would measure the coverage and frequency of networks or campaigns of poster sites. In essence this measures who passes a particular network of sites and how often they pass a site in the network, an OTS measurement system.

Because of the “passive” aspect of outdoor, coverage models based solely on OTS are regarded as inadequate and require of the medium a more rigorous research methodology. For this reason the outdoor industry has moved one step closer to measuring true contact by developing the concept of a visibility adjusted contact or VAC.

This VAC was pioneered in the UK as a visibility system or model that estimates the probability of an OTS being converted to a contact for every poster in a campaign and is covered in more detail later.
Travel Surveys.

The travel survey component of the outdoor research system was such a fundamental area that considerable time was taken in design and preparation. The purpose of the survey was not only to collect the journey routes over time of a representative sample, but also to research the level of usage of supermarkets, malls and public transport.

The travel survey was conducted by TNS Gallup and consisted of 3,047 interviews spread over 8 months. The sample was structured and randomised within region, with quotas on age, sex and working status imposed to ensure maximum representation.

The respondents journey routes were collected using a computer mapping based system linked to an electronic diary. Each respondent recorded all journeys in a paper diary “aide mémoire” during the interview week and the data was then transferred to the computer diary at interview. The computer system then prompted for each journey route and mode of travel, which was then captured at street level by using a predictive point and click system.

The surveys were conducted at the respondent’s home, where it is easier to predict the social and demographic profile before the interview, so minimising wasted contacts and facilitating correct geographical sampling.

The resulting journey data was then overlaid on the digital road skeleton and the known poster locations.

Traffic Flows.

The recent availability of digital “skeletons” of the road network has allowed for much more accurate research on both journey routes and on traffic flows. All government and local council traffic data that could be located was purchased and “snapped” or linked to the road network skeleton. Where traffic counts were not available, models were developed to estimate traffic flow, given the area and road type. These were provided by Statens vegvesen (Norwegian Public Roads Administration) and the local city authorities in Norway.

A similar process was undertaken for non-roadside environments with pedestrian entry/exits, actual counts and models generating the footfall at these locations. The counts of visitor data were acquired from Oslo T-banedrift AS (metro station visitors) and Norge NSB (railway station visitors). The retail footfall models were based on the Mall owner visitor data, AC Nielsen revenue figures and visitor numbers derived from the Travel Survey. For each store figures we calculated based on the average shopping basket values combined with the measured visits from the survey.

In the poster classification program, a GPS (Global positioning system) co-ordinate for every poster was collected. Using this data, it was possible to link each poster, through the road skeleton or site location, such as a station or shopping centre, to an individual traffic flow.
Opportunity-to-See (OTS).

The traffic flow is the coarsest of the available measures, the next step is to adjust this complete road flow to take into account the posters general orientation. For instance a “head-on” or perpendicular to the road poster, will only be seen when approaching from one direction. This would mean its OTS would be a half of the total road traffic flow. Whereas, a parallel poster can be seen when approaching from both directions.

In the non-roadside environments, a footfall allocation system was developed that took into account the number of entrances and exits to the location and the position of the panel within the station or shopping centre.

So what does this mean in relation to specific locations?

1. A parallel panel in a station entrance will receive an OTS of the total Entries and Exits.
2. A head-on panel in a station entrance will receive an OTS of a half total Entries and Exits.
3. A head-on panel in a shopping centre entrance will receive an OTS of a half total Entries and Exits.
4. A head-on panel at the entrance in a shopping centre with two entrances will receive an OTS of a quarter total Entries and Exits.
5. A parallel panel in a car park with a single entrance will receive an OTS of the total Entries and Exits.

Visibility adjusted contacts (VAC):

The research objective in the UK was to develop a visibility (conspicuity) model, to estimate the hit rate or noticeability of roadside posters, ignoring the content if possible, but taking the eccentricity, luminance, angular size and background into account.

Firstly a trawl was made of all the relevant psychological research undertaken previously around the world. This ranged from basic studies in Sweden to more complex work in Australia and Europe detailed below.

G. Johansson - Uppsala university. Set up an elaborate study with the help of the police. They erected various road-traffic signs on one side of a hill, and stopped drivers at lay-by on the other side of the hill. They then asked the drivers to report on the last sign they had noticed. (1966)

Cole and Hughes in Melbourne, placed discs of various sizes (up to 6 sheet size) on roadside lampposts. They then measured “noticeability” of discs in both a search task and a “conspicuity” attention task, by studying the time and places where drivers noticed or found the discs. They looked at eccentricity (distance from kerb side), luminance and angular size. (1984)

Unema and Rotting – Maastricht. Monitored video and assessed viewing direction using a eyemark recorder of drivers in a general study of where drivers look and how
their eye-movements vary with variations in the driving conditions or workload of the driver. (1992)

This previous research indicated the elements that needed to be considered if a poster and billboard model was to be designed.

A study was commissioned (1996) and designed at London University and conducted in the UK to test the effects of different factors on the noticeability of posters. The main factors examined were:

1. Eccentricity : distance from roadside.
2. Angular size. Bus-stop, Billboard, Supersite
3. Luminance. Illumination on and off, night and day.
4. Background : clutter.
5. Duration or distance of visibility.

200 photographs of roadside posters were commissioned to represent all posters sizes and environments from the drivers perspective of an approaching car. These photographs were assembled into “drives” of 15-minute duration, and each still scene was displayed on a large computer screen for 6 seconds, to simulate a drive-thru of a typical urban environment. 56 subjects undertaking different roles, driver/passenger, were then asked to view the drives while wearing an eye-movement recorder. The drives and photographs were combined in manner designed to neutralise the effect of any creative designs.

The eye-movement recorder operates by measuring reflected infrared light from the retina of the subject’s eye. Recording both the position and duration of each fixation. The eye is only focused at a fixation, typically some 200 milliseconds (msec) long, and is not focused during the rapid saccades between each fixation. See example recording below.

The resulting data, some 62,782 fixations were then analysed against the known locations of the posters in the scenes.
A computer probability model was designed that could animate the aspect and size of a poster, from its maximum visibility distance until it was passed by an observer. During this animation the size, aspect, and eccentricity are calculated every 10th of a second for the passage past the poster. The probability of a “contact” is then accumulated each 10th of a second, so the effect of the 6 second experimental exposure was negated, in this way the probability can be calculated on a 2 second passage or a 15 second passage. When these 10th second probabilities are combined in a binomial manner the total probability can be calculated for a passage past any particular poster layout at any speed.

The use of this probability model means that all the factors are interrelated as the “exposure” to a known poster layout is generated. There is no X or Y factor, which can be separated to say that factor A is more important than factor B as all factors vary in their importance in relation to one another and at varying distance from the poster. However, the contribution of the factors can be assessed by close study of the visibility matrix generated on all possible combination of criteria. Their order of importance is Size, Eccentricity, Distance, and Clutter. The application of this “model” would need the relevant data being collected for each and every poster in the research program. The visibility matrix is the property of POSTAR in the UK and has been licensed for use in Norway, it is not in the public domain.

Latterly with the reduction in size of computers it has been possible to record eye-movement data from within a car, without unduly interfering with the process of driving. In 2001 POSTAR undertook a comprehensive in-car study with Nottingham University. This study was used to confirm the findings of the previous studies and to investigate additional factors, such as distance of viewing. The visibility models were then adjusted to take into account this new more realistic research.

Further major research has since been conducted on the non-roadside environments of Travel and Retail locations. This research has taken the form of a calibrated and
correlated study of all known non-roadside poster environments using an active search task rather than direct eye-movement studies, as the pedestrian “viewpoint” is less directed than that of a road user. The data from these studies is as yet unpublished and has been licensed for use in Norway, as it is in the UK and elsewhere.

In Finland a separate eye-movement study was commissioned from Dr Barber and Birkbeck College London University. This was undertaken to investigate the visibility of certain types of panel found uniquely in Finland and Sweden; Non-urban highway billboards, Lamppost panels, Tram and single-decker bus posters. Four hundred and eighty driving scenes were photographed containing the required test material in different conditions, winter/summer and at varying distances. Then 50 Finish respondents were recruited to take part in the visibility experiment.

The scenes were presented in drives by computer and eye-movement data collected. This data was then “fused” with the original POSTAR models to create VAC contact probabilities for the Finland poster types.

The Norwegian visibility models are a fusion of the POSTAR studies and the Finland/Sweden studies.
Poster Classification

The requirement for a classification methodology was dictated by the industry adoption of the concept of Visibility adjusted contacts (VAC). The methodology adopted was of digitally photographing and consequent computer based measuring of the aspects of every poster. In addition on each site visit other relevant data was also collected. For instance, site area type, road width, traffic lanes, GPS co-ordinates etc.

By the use of sophisticated software, the important visibility factors could be measured directly from the digital photographs and in conjunction with known area traffic speeds the visibility adjusted contact rate could be calculated.

The photographs themselves were taken under strict criteria to show the drivers perspective of the poster on approach, and using specifications on maximum distance and obstruction.

Given this VAC measure and the previously detailed allocation of traffic flow and hence OTS, we can calculate for each panel, how many passages result in an actual “contact” with the advertising.

Roadside, Retail and Travel environments.

The description of the process of allocating Flow, OTS and VAC to each roadside poster, outlined previously, has been extended into two other environments, those of non-roadside. The “Retail” environment encompasses all locations where a transaction of goods occurs, shopping malls, supermarkets and pedestrian precincts. The “Travel” environment encompasses all locations where the primary purpose is
that of travel, including rail stations, subway stations, bus stations, car parks and tram stops.

The Flow for the non-roadside environments is the total number of entry and exits at any particular location. This data was either a directly recorded number of passages in the cases of Rail, Subway, Tram and large shopping malls, or derived from a model using the number of facilities at the location and the facility usage derived from the Travel survey questions on these environments.

The OTS for each poster location for non-roadside is allocated in a more complex manner than that of roadside, as the number of entrances and the posters location in a complex had to be taken into account.

The VAC is derived from the poster size and its location within the specific non-roadside environment, so that a corridor poster has a different visibility to that of a poster on a platform, or in an entrance.

The posters environment, location within, and viewing position to passing pedestrians was recorded in a similar way to the roadside poster-by-poster classification procedure. Including digital photographs of each poster and its immediate surroundings.
Poster and Cafas terminology

Coverage or Reach

The coverage or reach of a campaign is the number of individuals in a population who have seen the advertising at least once, sometimes it is expressed as a percentage of the population, sometimes as a direct number. For instance, a campaign could have covered or been seen by 47% of the Adult population or alternatively it may be reported that the campaign reached 250,000 15-24 year old adults.

Frequency

It will be realised that when a large population has been covered by a medium like posters, some people will have seen the campaign only once, but some will have seen it many times, and frequent travellers many many times. If we calculate the average number of times that the average individual saw the campaign, then we call this the average frequency of the coverage.

Hence we now have coverage and frequency

N plus (N+) coverage

Simple coverage or 1+ coverage is a measure of all the people who have seen a campaign at least once, so the resulting number includes the people who have seen it only once, but also those who have seen it twice, three times, four times etc. etc. This is why the coverage level is often referred to a 1 plus (1+) as it’s a measure of who has seen the campaign once or more (+).

The cafas system allows the calculation of 1 + to 20 + coverage levels. So for example, if 4+ was chosen, the system would calculate the coverage level of the population who had seen the campaign four or more times. The population who had only seen the campaign once, twice or three times would be removed from the coverage estimate.

One consequence of this is that the average frequency for 4+ is higher than 1+. This is because we have removed the people from the frequency distribution who had only made low numbers of passages. In consequence the average frequency of the remaining coverage will mathematically rise.

It should also be noted that the N+ coverage is visibility adjusted, so that to “see” a campaign four or more times, the number of passages required is many times this, depending on the visibility of the posters in the campaign.

Flow

In the roadside environment, this is the total number of passages past an individual site regardless of its visibility, it is a measure of “busyness”. It is calculated as the total vehicular traffic past the site multiplied by an occupancy factor of 1.6, plus the total pedestrian traffic past the site.
In the non-roadside environments, it is the total number of entry and exits at a particular location, not necessarily past the poster, as this further factor is dealt with in the OTS measure.

In the Cafas system the numbers shown on all screens are “average adult flows per week”. (Av Flow P/W). This allows for direct comparisons between the media owner and size digest pages and the planner and campaign screens regardless of campaign period.

This Av Flow P/W number is describing the average number of “people passages” past the panels in that network or for that size in a region. Note; it is not the average number of “individual people” who pass each panel, because the same person may pass the panel more than once over a period of 7 days. For example, one individual may count as 10 or 14 “people passages” depending on how many times they pass a particular panel in a week.

The total flow or passages for a group of panels is: the average flow per week X the total number of panels.

The average flow per week does not change if the campaign is run for more than 1 week. However the total flow then becomes: the average flow per week X the total number of panels X number of weeks.

The Flow at any particular location is adjusted by month, depending on daylight hours and the posters illumination status. The displayed Flow is for all adults (12-74 yr old) and will not change when a different social group is selected.

OTS

In the roadside environment, this is the flow at each location adjusted for poster orientation or direction. For instance a “head-on” or perpendicular to the road poster, will only be seen when approaching from one direction and this would mean its OTS would be a half of the total road traffic flow. Whereas, a parallel poster can be seen when approaching from both directions and would be allocated the total flow for the road.

In the non-roadside environments, it is the total flow for the location (a particular Mall or station) adjusted for poster position with the location.

For example, it may be the total flow divided by the number of entrances or platforms at the location and also dependent on the poster position within the location, i.e. whether the poster is in the car park, the entrance or a central area like a ticket hall. More detail in section
Opportunity-to-See (OTS).

This \textit{Av OTS P/W} number is describing the average number of adult passages (15+) past the panels in that network or for that size in a region that result in a potential opportunity to contact the poster.

In the Cafas system the numbers shown on all screens are “average adult OTS per week”. (\textit{Av OTS P/W}). This allows for direct comparisons between the media owner and size digest pages and the planner and campaign screens regardless of campaign period.

The \textit{total OTS} for a group of panels is: the average OTS per week $\times$ the total number of panels.

The average adult OTS per week does not change if the campaign is run for more than 1 week as its is a “per week” (PW) value. However the \textit{total OTS} then becomes: the average OTS per week $\times$ the total number of panels $\times$ number of weeks.

The OTS at any particular location is adjusted by month, depending on daylight hours and the posters illumination status. The displayed \textit{Av OTS PW} is for all adults (15+) and will not change when a different social group is selected.

\textbf{VAC}

The visibility adjusted contact for any poster is the OTS reduced using the probability based visibility model.

For roadside posters this model is dependent on the posters physical characteristics, the size, the location relative to the road, the viewing distance and the local traffic speed.

For non-roadside the model is dependent on the environment type, its size and location.

This \textit{Av VAC P/W} number is describing the average number of adult eyes-on-panel “contacts” for the panels in that network or for that size in a region.

In the Cafas system the numbers shown on all screens are “average VAC per week”. (\textit{Av VAC P/W}). This allows for direct comparisons between the media owner and size digest pages and the planner and campaign screens regardless of campaign period.

The \textit{total visibility adjusted contacts (VAC)} for a group of panels is: the average VAC per week $\times$ the total number of panels.

The average \textit{VAC} per week does not change if the campaign is run for more than 1 week. However the \textit{total VAC} then becomes: the average VAC per week $\times$ the total number of panels $\times$ number of weeks.
The VAC at any particular site is adjusted by month, depending on daylight hours and the posters illumination status so the average VAC for a group of posters will change month by month depending on daylight hours. The displayed \( \text{Av VAC PW} \) is for all adults (15+) and will not change when a different social group is selected. The total \text{Visibility adjusted contacts} (VA contacts) changes by social group.

**VAC coverage**

Is the estimated percentage proportion of the selected audience by region that will have at least one eyes-on panel contact with the campaign of N panels over the time period selected.

The displayed VAC coverage will change when a new social group is selected.

Displayed in column \( \text{(VAC cover\%)} \)

**Population covered**

Is the VAC cover translated to the number of the selected social group in that region, that will have at least one contact with the campaign.

\[
\text{VAC cover\%} \times \text{Total region social group population} = \text{POP cover}
\]

For example if there are 1,000,000 males in a region, and you have a VAC cover of 56% then you will have covered 560,000 males.

Displayed in column \( \text{(POP Cover)} \)

**Visibility adjusted contacts**

Is the total number of “eyes-on-poster” contacts generated by the campaign over the selected number of days for the selected social group.

It is a mathematical calculation being the total VAC per week of each poster \( X \) the number of weeks \( X \) the proportion of contacts made by the social group.

In the planner it is the \( \text{Av VAC P/W} \ \times \) the number of posters \( X \) the number of weeks.

Displayed in column \( \text{(VA Contacts)} \)
Visibility adjusted average frequency

Is the average number of visibility adjusted contacts (VAC) that the covered population (selected social group) will have with the campaign over the selected number of days, 7 or 14 or 21 etc.

It is a mathematical calculation being the total Visibility adjusted contacts divided by the number of people covered.

For example if the campaign covers 1,000,000 adults and there are 13,500,000 Visibility adjusted contacts, then the average number of contacts per person is 13.5

Displayed in column (VA Av Freq)

Cost per thousand

The term “Cost Per Thousand covered” (CPT) is a measure of how much it has cost to reach or cover one thousand members of the population. Its is calculated as the total cost of the campaign divided by the population covered.

For example, if a campaign cost 500,000 Euro and the campaign reached 4.5 Million or (4,500 thousand) people. Then the cost per thousand covered would be calculated as:

\[
\frac{500,000}{4,500} = 111.11 \text{ Euro}
\]

A similar but alternative measure is “Cost per thousand contacts” (CPTC) this calculation takes into account the frequency that the medium provides. If for example the same campaign had an average frequency of 7.2 then the CPT contacts is:

\[
\frac{500,000}{4,500 \times 7.2} = \frac{500,000}{32,400} = 15.43 \text{ Euro}
\]

GRP

GRP (Gross Rating Points) is a measure of the total number of “contacts” that a campaign has achieved, basically the percentage of the population X (times) the average number of times this population have seen the campaign. In each medium it is calculated the same way, but has slightly different meanings.

In TV, when a buyer buys a spot, each spot achieves an audience. This is called it's 'rating' 'TVR' or 'GRP'.

If an example spot has a GRP of 10, then this means that the spot has reached 10% of the universe (freq=1). So if the universe is 4,000,000 the 'impacts' are 10% of that i.e. 400,000. There is nothing different here from how we handle this calculation in Posters. However, the TV community add up the GRP's achieved across all of the
OTS to give a 'total GRP'. This could be for example 200 GRP's. This means that the impacts are the equivalent of 2 X the universe i.e. 8,000,000.

Of course this does not give any indication of frequency distribution. For this you have to refer to the TV research panel i.e. the equivalent of the OUTDOOR IMPACT travel survey sample. Of course some people will see the spot just once, some twice etc. In effect, the individual audiences to each spot will and must add up to the sum of the frequency distribution. So total GRP's can be calculated in many ways e.g.

For example:
1. Total impacts / universe X 100
2. Addition of individual spot (or panel) GRP's
3. Average frequency X coverage X 100 (e.g. 4.5 X 90% X 100 = 405 GRP's)
4. % audience seeing it once X 1 - plus % audience seeing it twice X 2 - plus % of audience seeing it three times X 3 etc.

Total GRP's, coverage and frequency plus total frequency are often shown as part of the campaign results. The above definitions are used in all media. Exceptions are TV where GRP's are called TVR's or 'ratings' and Radio where OTS is called OTH (opportunity to hear).

Share of voice

In advertising terms, the share of voice is the proportion of the available media or time that will be bought for the particular campaign.

For example, if two beer manufacturers were launching a new beer at the same time, then they would want to have at least an equal “share of voice” so that their own advertising message was not overwhelmed by the other manufactures advertising.

In posters, if we select a certain size, for example bus-stop posters, then the share of voice is the proportion of available posters in a region. If there were 1000 posters in a region, then 200 posters would be a 20% “share of voice”.

The cafas calculated share of voice is for size and environment and is not media owner sensitive. For example if we are planning 6 sheet roadside and choose distribute by share of voice, the system calculates the percentage of all roadside 6 sheets by region.

Illumination

The Flow/OTS and VAC within the research system are sensitive to time of year, daylight hours and hence illumination of the panels.

A panel is only counted as having illumination if and only if there is a directly built-on illumination device. This can be a back-light or a top or bottom spot light. Ambient street or location lights are not recognised as sufficient. Posters indoors, such as inside shopping Malls are deemed illuminated as there is sufficient lighting at all times for the poster to be seen.
Panels with 24 hour illumination are flagged and receive an uplift of 3% on an average month those illuminated only after sunset.

Distribution

The coverage of a network is not only dependent on the size and quality of the posters within the campaign, but also on how well the posters are spread through a modelled region. The cafas system calculates a measure of distribution and adjusts the final VAC coverage to correlate with this. For example, if we were to have 100 posters spread evenly across Oslo, they would achieve higher measured coverage than if 100 equal quality posters were just spread across the western part of Oslo.
## Coverage model areas

<table>
<thead>
<tr>
<th>District</th>
<th>DistrictName</th>
<th>Model Area Name</th>
<th>Model Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>0301</td>
<td>Oslo</td>
<td>Oslo Met + Oslo Region</td>
<td>1</td>
</tr>
<tr>
<td>0216</td>
<td>Nesodden</td>
<td>Oslo Region</td>
<td>2</td>
</tr>
<tr>
<td>0217</td>
<td>Oppegård</td>
<td>Oslo Region</td>
<td>2</td>
</tr>
<tr>
<td>0219</td>
<td>Bærum</td>
<td>Oslo Region</td>
<td>2</td>
</tr>
<tr>
<td>0220</td>
<td>Asker</td>
<td>Oslo Region</td>
<td>2</td>
</tr>
<tr>
<td>0213</td>
<td>Ski</td>
<td>Oslo Region</td>
<td>2</td>
</tr>
<tr>
<td>0228</td>
<td>Rælingen</td>
<td>Oslo Region</td>
<td>2</td>
</tr>
<tr>
<td>0230</td>
<td>Lørenskog</td>
<td>Oslo Region</td>
<td>2</td>
</tr>
<tr>
<td>0231</td>
<td>Skedsmo</td>
<td>Oslo Region</td>
<td>2</td>
</tr>
<tr>
<td>0233</td>
<td>Nittedal</td>
<td>Oslo Region</td>
<td>2</td>
</tr>
<tr>
<td>0235</td>
<td>Ullensaker</td>
<td>Oslo Region</td>
<td>2</td>
</tr>
<tr>
<td>1247</td>
<td>Askøy</td>
<td>Bergen Region</td>
<td>C</td>
</tr>
<tr>
<td>1243</td>
<td>Os</td>
<td>Bergen Region</td>
<td>C</td>
</tr>
<tr>
<td>1245</td>
<td>Sund</td>
<td>Bergen Region</td>
<td>C</td>
</tr>
<tr>
<td>1201</td>
<td>Bergen</td>
<td>Bergen Region</td>
<td>C</td>
</tr>
<tr>
<td>1246</td>
<td>Fjell</td>
<td>Bergen Region</td>
<td>C</td>
</tr>
<tr>
<td>1244</td>
<td>Austevoll</td>
<td>Bergen Region</td>
<td>C</td>
</tr>
<tr>
<td>1663</td>
<td>Malvik</td>
<td>Trondheim Region</td>
<td>D</td>
</tr>
<tr>
<td>1648</td>
<td>Midtre Gauldal</td>
<td>Trondheim Region</td>
<td>D</td>
</tr>
<tr>
<td>1653</td>
<td>Melhus</td>
<td>Trondheim Region</td>
<td>D</td>
</tr>
<tr>
<td>1662</td>
<td>Klæbu</td>
<td>Trondheim Region</td>
<td>D</td>
</tr>
<tr>
<td>1601</td>
<td>Trondheim</td>
<td>Trondheim Region</td>
<td>D</td>
</tr>
<tr>
<td>1120</td>
<td>Klepp</td>
<td>Stavanger Region</td>
<td>E</td>
</tr>
<tr>
<td>1122</td>
<td>Gjesdal</td>
<td>Stavanger Region</td>
<td>E</td>
</tr>
<tr>
<td>1119</td>
<td>Hå</td>
<td>Stavanger Region</td>
<td>E</td>
</tr>
<tr>
<td>1103</td>
<td>Stavanger</td>
<td>Stavanger Region</td>
<td>E</td>
</tr>
<tr>
<td>1124</td>
<td>Sola</td>
<td>Stavanger Region</td>
<td>E</td>
</tr>
<tr>
<td>1127</td>
<td>Randaberg</td>
<td>Stavanger Region</td>
<td>E</td>
</tr>
<tr>
<td>1102</td>
<td>Sandnes</td>
<td>Stavanger Region</td>
<td>E</td>
</tr>
<tr>
<td>1121</td>
<td>Time</td>
<td>Stavanger Region</td>
<td>E</td>
</tr>
<tr>
<td>1149</td>
<td>Karmøy</td>
<td>Cities 50K +</td>
<td>F</td>
</tr>
<tr>
<td>1106</td>
<td>Haugesund</td>
<td>Cities 50K +</td>
<td>F</td>
</tr>
<tr>
<td>0105</td>
<td>Sarpsborg</td>
<td>Cities 50K +</td>
<td>F</td>
</tr>
<tr>
<td>0106</td>
<td>Fredrikstad</td>
<td>Cities 50K +</td>
<td>F</td>
</tr>
<tr>
<td>0805</td>
<td>Porsgrunn</td>
<td>Cities 50K +</td>
<td>F</td>
</tr>
<tr>
<td>0806</td>
<td>Skien</td>
<td>Cities 50K +</td>
<td>F</td>
</tr>
<tr>
<td>1902</td>
<td>Tromsø</td>
<td>Cities 50K +</td>
<td>F</td>
</tr>
<tr>
<td>0602</td>
<td>Drammen</td>
<td>Cities 50K +</td>
<td>F</td>
</tr>
<tr>
<td>1001</td>
<td>Kristiansand</td>
<td>Cities 50K + Small Cities and Countryside – Remainder of Country</td>
<td>F</td>
</tr>
<tr>
<td>Others</td>
<td>All other Kommuns</td>
<td>Cities 50K + Remaining of Country</td>
<td>G</td>
</tr>
</tbody>
</table>
Poster orientation.

Describes the posters orientation (direction or layout) in regard to the viewing road.

The following descriptions are based on a simple two-way or bi-directional road.

- **Head-on** – Perpendicular to road, and facing one traffic flow.
- **Parallel** – Lying along the road, and so collecting both traffic flows.
- **Angled** – Diagonal to road, Not perpendicular or parallel, but still facing only one traffic flow.
Program usage and screen content.

On starting the program the main screen will appear as a blank worksheet. The menu along the top allows the selection of the various functions.

The system allows the use of multiple windows on the data, so for instance, you can see the digest of media owner sheetage, and at the same time open the campaign planner window or have multiple planner windows open.

Currently implemented options are:

1) Summary/Digest: This produces a digest or summary of the panels within the system by selected option.

2) Analysis: This will allow the user to analyse “specific” networks or campaigns of panels.

3) Campaign planner: This allows the user to estimate the coverage, which could be achieved by using particular weights of “average” panels by region.

4) Multiple Campaign/Network Analysis: This allows the user to save the results from networks or campaigns and compare between networks.
The system is grid based, and all displayed data can be cut and pasted into Excel, by the use of the Edit > copy and Edit >paste functions inherent in Microsoft windows. (Control-C and Control-V, Note there is no need to highlight the cells in each grid)

Edit >Copy and then Edit >paste into Excel will produce the following:
Digest or Summary of stock

The starting proposition is that similar panels are classified into environments depending on their main criteria. All roadside posters are classified using the same methodology and so are summarised together. In addition panels in Railway stations, or Metro stations or in other environments where the main object of the passing audience is to “travel” are included together. Likewise for panels in a retail environment, like Malls, supermarkets or other “purchase” type locations.

Each category or environment is analysed and summarised by size and coverage region (Universe, Oslo, Bergen etc) and onwards down to the smallest region of District or Kommun.

Sheetage by media owner:
This window allows the interrogation of the number of panels or sheetage by size by area within the system.

1) Cover region: shows the sheetage by the Coverage model areas for Norway
2) District: shows the sheetage by the Kommun smaller areas in Norway.
Sheetage by Kommun/district:

This window shows a summary of sheetage by size for all kommun in Norway, this selection may take some time to generate its results.

It is possible to generate the Sheetage by District Digest filtered by Media Owner or by universe. When you enter this screen you have the option to select by Universe or by Media Owner.

Once a Sheetage digest is calculated it is saved in the current CAFAS database. If you have already calculated a Universe sheetage digest in this version of the CAFAS database it displayed on entry to the Sheetage by District screen. Any saved digest will be displayed very quickly, others may take some time, but then will be saved.
Flow by media owner:

This window shows the average adult passage flow per week, by region, size and month past each panel in the selected area. These are selectable by poster environment, Roadside, Retail and Travel.

The flow for each panel is calculated as the total vehicular and pedestrian adult passages (15+), averaged for each size over the selected month.

In the example above, the average flow past each of the Eurosize in the Travel environment is 155,922 adults per week.

The Flow is a daylight adjusted flow figure. The volume of passages that take place in daylight adjusts the Flow for un-illuminated posters. For illuminated panels the volume of traffic is 100% as the panel is visible in both daytime and night-time.
Traffic in daylight.

The zones are borded by the midpoints between the zone centre cities,

<table>
<thead>
<tr>
<th>Zone</th>
<th>Centre city</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tromso</td>
</tr>
<tr>
<td>2</td>
<td>Bodo</td>
</tr>
<tr>
<td>3</td>
<td>Trondheim</td>
</tr>
<tr>
<td>4</td>
<td>Oslo</td>
</tr>
</tbody>
</table>
OTS by media owner:

This window shows the average adult passage OTS (opportunity to see) per week, by region, size and month past each panel in the selected area. The OTS is the flow adjusted by direction of travel. For example, a “head on” panel will achieve a half of the flow of a particular road, whereas a parallel panel will achieve the whole flow, as the people who pass will have on opportunity to see it from whichever direction they make the passage. The OTS screens are selectable by poster environment, Roadside, Retail and Travel.

The OTS is an orientation and daylight adjusted flow figure. For example head-on panels are only allocated 50% of the total road flow, as they can bee seen from one direction only, whereas parallel panels are allocated 100% of the total road flow. This percentage OTS is then adjusted by the volume of passage that take place in daylight for un-illuminated panels. For illuminated panels the volume of traffic in daylight is 100% as the panel is visible in both daytime and night-time.

The OTS shown is the Average Opportunity-to-See (OTS). Per Week (Av OTS PW); this is the common measure used throughout the cafas system, both in the campaign planner and campaign analysis sections.
VAC by media owner:

These windows show the average adult passage visibility adjusted contacts (VAC) per week, by region, size and month past each panel in the selected area.

The VAC is a visibility and daylight adjusted OTS figure. The probability of seeing each panel is calculated from its classification survey data, and the number of visibility adjusted contacts derived. The average VAC is then calculated for each company/size/region. For example as above, the average visibility adjusted contact per week for Eurosize in the roadside environment is 19,880 in May.

Factors such as viewing distance, set-back from road, size, angle and traffic speed, vary the figure for each panel in each region.

So it should be expected that the average VAC per week for a Eurosize in Oslo will be higher than for a similar panel in Stavanger.

The VAC shown is the Average VAC per week (\( \text{Av VAC PW} \)), this is the common measure used throughout the cafas system, both in the campaign planner and campaign analysis sections.
Network or Campaign Analysis

The network/campaign analyser is designed to estimate coverage of specific sets of panels in a campaign when the system is provided with a list of the specific panels. The program looks-up the actual panel scores (Flows/OTS/VAC) for each individual poster listed in the network/campaign (Note that the campaign planner detailed later in the manual, only uses average panel scores.)

In addition to reading the “actual audience data” for the selected panels, the system will also analyse the “distribution” or spread of the network or campaign. It does this by checking how many Town or Kommun centres are allocated panels in the network for each coverage region. (Using GPS location of poster panels).

A further note explaining distribution or spread of a campaign. It is theoretically possible to have one network with more posters in it than a second network, but the second network producing higher coverage levels, by reason of it being more widely distributed than the first.

The option is reached by selecting on main menu bar: Analysis > Package or Campaign

The format of the input files is described in an associated document (Industry Standard Coding Structure Campaigns.doc)

Network files will typically be provided by the media owners.

A typical network/campaign file details the panels and dates as in the example below:
Network or Campaign file selection.

The option is reached by selecting on main menu bar: Analysis > Package or Campaign

The system is designed so that single or multiple networks/campaigns can be analysed together, in a “pick and mix” manner

Instructions on how to analyse a package, network or campaign:

1. Press the “add files” button, then select the required files, multiple selections are allowed

For each file selected a line will appear on the “Files” tab as shown above:

2. Press the “analyse” button, the system will then read in the panels in the campaign files and match the panels to the database of classification data.
3. The window will flip to the combined cover screen once the campaign files have been analysed see below:
**Campaign sheetage**

The Tabs along the top of the resulting window give a different analysis on various criteria, such as illumination and site area type, and additionally the coverage for each environment (Roadside/Travel/Retail) of the campaign or network.

Details of Tab analysis contents:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Files</td>
<td>Simply lists the files included in the analysis, files may be removed or added.</td>
</tr>
<tr>
<td>Sheetage</td>
<td>Details the size and owners of the package. All panels in file that matches to database.</td>
</tr>
<tr>
<td>Angle</td>
<td>Head-on, Angled or Parallel panel count by size and owner of classified panels.</td>
</tr>
<tr>
<td>Flow</td>
<td>Shows the average adult Flow per week by size and owner.</td>
</tr>
<tr>
<td>OTS</td>
<td>Shows the average adult OTS per week by size and owner.</td>
</tr>
<tr>
<td>VAC</td>
<td>Shows the average adult VAC per week by size and owner.</td>
</tr>
<tr>
<td>Illuminated</td>
<td>Count of illuminated panels by size and owner.</td>
</tr>
<tr>
<td>Non-illuminated</td>
<td>Count of non-illuminated panels by size and owner.</td>
</tr>
<tr>
<td>Site Area</td>
<td>Count of roadside panels in each type of site area and owner.</td>
</tr>
<tr>
<td>Ped Site Area</td>
<td>Count of non-roadside panels in each type of site area and owner.</td>
</tr>
<tr>
<td>Cover</td>
<td>Shows the same columns as the campaign planner screen. However, the system has calculated the actual average weekly adult Flow/OTS and VAC for the panels in the campaign file.</td>
</tr>
</tbody>
</table>
Network/Campaign analysis – Roadside:

Each coverage tab (Roadside, Travel or Retail) shows the contribution in coverage terms that each poster environment is making to the total coverage of the campaign, the **combined** tab provides the **total campaign coverage**.

Note that “use campaign file dates” option has been selected. This allows for mixing of networks of varying dates, for instance Eurosize for 1 week and billboards for 4 weeks. In addition the reduced columns has been selected for clarity. The option to take the campaign period from the screen also exists.

The columns in the cover grid (above) display the following numbers:

<table>
<thead>
<tr>
<th>Panels</th>
<th>The number of classified (and so contributing) panels by model region.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Av Flow</td>
<td>Shows the average traffic Flow in adults 12+, for the indicated region and selected size per week. This number can be checked by opening the digest &gt; Flow by media owner screen. The average Flow per week will match that displayed in the campaign planner.</td>
</tr>
<tr>
<td>Av OTS</td>
<td>Shows the average directionally adjusted Opportunity-to-See (OTS) in adults per week, for the indicated region and size.</td>
</tr>
<tr>
<td>Av VAC</td>
<td>Shows the average number of visibility adjusted contacts VAC, in adults per week, for the indicated region and size.</td>
</tr>
<tr>
<td>VAC cover%</td>
<td>Shows the estimated VAC coverage which is the proportion of the selected audience by region that will have at least one contact with the campaign of X panels over the time period selected, in the example above this is 14 days.</td>
</tr>
</tbody>
</table>
POP Cover
Shows the Population covered as the number of the selected social group in that region, that will have at least one contact with the campaign.

\[(\text{VAC cover\%} \times \text{Total region social group population} = \text{POP cover})\]

VA Contacts
Shows the total number of Visibility adjusted contacts (VAC) that the selected social group will have with the campaign.

VA Av Freq
Shows the Visibility adjusted average frequency which is the average number of visibility adjusted contacts (VAC) that the covered population will have with the campaign over the selected number of days.

GRP
Poster equivalent “ratings” for the campaign. See section in cafas terminology on GRP

CPT
Poster cost per thousand, either contacts or covered. See section Cost Per Thousand

Network/Campaign analysis – Travel:
Each coverage tab (Roadside, Travel or Retail) shows the contribution in coverage terms that each poster environment is making to the total coverage of the campaign. (See the combined tab for the total coverage of the campaign)

The travel coverage component is shown below:

It should be noted that there is a minimum campaign analysis size for each region. The current minimum is set to 2 posters.
Network/Campaign analysis – Retail:

Each coverage tab (Roadside, Travel or Retail) shows the contribution in coverage terms that each poster environment is making to the total coverage of the campaign. (See the combined tab for the total coverage of the campaign)

The Retail coverage component is shown below:

It should be noted that the Retail environment is significantly different to both Roadside and Travel.

Roadside and Travel will have high coverage and frequency figures as the population will make multiple passages past posters in the campaign over the period of a week or more.

In the Retail environment there may be a lower average frequency as the population will visit these locations less often. The coverage may be larger per 10,000 VAC because there may be less repeat passages.
Network/Campaign analysis – Transport (Buses or Trams):

To be available in phase II of project.

Panels without scores

The Campaign/Network Analysis program will match the input poster details (site and panel number) to the database and allocate the correct Flow/OTS/VAC to each panel in the campaign. However, there may be panels that will not be “scored” and the system will display the reasons for this on the “panels without scores” tab.

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Problem</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Panel</td>
<td>The Site/Panel number is not in the Classification system (PSS)</td>
</tr>
<tr>
<td>Demolished</td>
<td>Warning only, the panel has been indicated as demolished in the classification system (PSS). If previously classified the score is allocated normally.</td>
</tr>
<tr>
<td>Awaiting classification</td>
<td>Panel is in the Classification system (PSS) but has not yet been classified or is not fully classified.</td>
</tr>
<tr>
<td>No roadside flow available</td>
<td>No roadside flow can be allocated, the Street Name is unknown and the GPS does not place the panel within 200m of any other road.</td>
</tr>
<tr>
<td>No roadside visibility Q3/4</td>
<td>There is no roadside visibility indicated in the classification system (PSS) on questions 3 and 4, vehicles and pedestrians.</td>
</tr>
<tr>
<td>No travel flow available</td>
<td>There is incomplete or inconsistent data in the classification system preventing an allocation of footfall.</td>
</tr>
<tr>
<td>No retail flow available</td>
<td>There is incomplete or inconsistent data in the classification system preventing an allocation of footfall.</td>
</tr>
</tbody>
</table>

The total campaign sheetage is shown on the “Campaign sheetage” tab, this may be different from the total on the “Combined cover” tab, the difference will be made-up by the panels without scores.
Network/Campaign analysis – Combined:

Each coverage tab (Roadside, Travel or Retail) shows the contribution in coverage terms that each poster environment is making to the total coverage of the campaign, the combined tab adds the resulting coverage using a combination model to measure the “overlap” from each environment. The “overlap” being the people who see the campaign in multiple environments, Roadside and Retail, or Retail and Travel etc.

An explanation of the overlap measures can best be done using the following example. It is possible that on adding retail panels to a large roadside campaign they may not significantly increase the coverage of the campaign. This is because, the people who travel to the retail locations will almost certainly pass the campaign on the roadside at some point over the campaign period.

The combined or total coverage of a mixed Travel, Retail and Roadside campaign is shown below: Note using campaign file dates (option).
The CAFAS Analysis function has had two charting options.

These charts show:

1. The increase in Cover over time
2. N plus coverage at the selected time period.

The Charts are available from the main menu bar at the top of the CAFAS screen after using the Campaign Analysis screen. The operate on each Coverage Tab, so can be chosen to show either the Combined cover or Roadside/Retail/Travel/Transport cover.

The charts are offered in 5 options, three Cover over time and two N Plus.

*Note the campaign should be “Analysed” before selecting the chart options.*

Please note that the “Use Campaign File Dates” is not used and should be unticked before using the chart options. The number of days used in the charts is taken from the days box or the days 14 / 28 as selected on the option menu.

The charts are produced for the Target Market/ Month / Number of days and N+ selected on the main screen.
The Cover over time charts are available with three options. The first option charts a variable number of days (from 1 to 28) to be chosen dependent on the number of days selected on the screen in the days box and the particular coverage tab chosen. (Roadside/Retail/Travel/Buses).

Two are fixed length charts available, 14 days and 28 days.

The chart below is produced using 7 days, the default in the days box.

By changing the number of days required, to 20 in this case, This Cover over time chart may be used for any period up to a maximum of 28 days.
The previous example shows a chart for “Combined Total Cover”. Charts are available for each “Environment” - Roadside, Travel, Retail, Transport (Bus/Tram) and Combined Total Cover.

To select a Roadside chart click on the “Roadside” Tab and then choose the chart required.

The N Plus charts are available in two options. Either from 1 to 10 or 2 to 20. The 1st option on the menu and allows charts of variable number of days controlled by the number of days on the screen.

*Please note that the “Use Campaign file dates” is not used to set the number of days on the chart.*
N Plus charts can be selected for the same environments as the Cover over time function.
Campaign Charts - Copy and Pasting

How to copy the charts into Excel and Word documents

The charts exist on the computer system as both a table of numbers and a picture. You will need to select which is required when using the Copy and Paste function.

To copy and paste the charts into Excel and Word from Cafas you will need to follow the instructions below:

**Copying the Chart:**

1) To copy the chart use Edit > Copy

![Image of the chart being copied]

2) To paste the chart picture use Edit > “Paste Special” in your required target program, Excel or Word.

![Image of the chart being pasted into Excel]

3) Select bitmap

![Image of the Paste Special dialog box in Excel]
4) The Chart picture will be pasted into your target program, Excel or Word.

Copying the data behind the chart:

1) To copy the data use Edit > Copy

2) To paste the Table of numbers use Edit > Paste in your required target program, Excel or Word.
3) The table of numbers used in the chart is pasted.
Analysis Campaign Comparison

The campaign comparison option has been designed so that the user may view the results of multiple networks/campaigns or mixtures of networks/campaigns on the same screen for the purposes of comparing coverage and frequency results.

The process to access this data is as follows:

1. Analyse a network or campaign in the Analysis > Package or Campaign option.
2. The window will show “Combined Total cover”.
3. Use option File > Save Campaign. (enter your own description if required)
4. Repeat 1 to 3 above on as many campaigns as required.

The details of this network / campaign or mixture of networks is then saved to a file in the Cafas database.

NOTE if you are using a centrally administered database these are saved in the central file.

The Campaign Save screen in Pictures:

After analysis of the chosen network or campaign file: use File >Save Campaign
A screen is shown that defaults to the network or campaign file name, but allows the user to enter their own description as required by overtyping in the central box. This is necessary if a combination of networks / packages have been analysed.

The details of this network / campaign or mixture of networks is then saved to a file in the Cafas database.

When multiple networks / campaigns have been “saved” it is then possible to view them in the campaign comparison screen.
The Campaign comparison screen.

The option is accessed from the menu by choosing Analysis > Campaign comparison.

The screen will appear blank.

It is now possible to choose or “load” the specific campaigns on which comparisons are required.

From the File menu choose the option > Load Campaign (see above picture)

When the > Load Campaign option is selected the system will display all of the previously analysed and saved networks / campaigns.
The campaigns required can be selected in three ways

1. Control + Left Click on name highlights and selects multiple networks / campaigns, then press load button
2. Double click selects and loads one single campaign
3. Click name to highlight > Press load button, selects a single campaign

You can delete campaigns you no longer want by clicking on the tick box in the first column and then pressing the “Delete” button.
The campaign comparison screen is then displayed with the previously selected networks / campaigns. The default selections are:

- All regions
- Combined Coverage
- All Adults 15+
- Using Network / Campaign dates for duration
- N+ = 1

All of the options may be changed by simple selection of the required region, environment (Roadside/Retail/Travel/Transport), target group, dates, N+ level.

The columns of the displayed data may be sorted in either descending or ascending order by simply clicking on the required heading row, at which point the sort will take place and a > or < appear in the sorted column heading. (The lowest Freq first shown in example below)
Cost Per Thousand

Both the package analysis and campaign planner sections of the system have a built in cost per thousand facility. This is explained below for the campaign analysis but operates in a similar way for the campaign planner section.

In the planner there is a cost per thousand tab as seen above, this tab allows the cost of the campaign to be entered by region and environment if this is known, or as a total per environment if only this is known. If you enter a figure in the Total/Total box, this value is distributed equally amongst all panels regardless of Region/Media type unless a specific distribution method has been chosen.

**status CPT**

The status indicator is there to show whether CAFAS can accept the figures on the screen.

The rules are as follows.

- If there is a “Total Total” there can be no other figures.
- If there are any figures in the “body”, that is the Region rows for any Model then there can not be any figures in the Total row or Total column.
- If there is any figure in the Total column there must be no figures in the Total row.

In the example above we have chosen a CC + JCD billboard network distributed across Norway. We estimate for planning purposes that this will cost 2,000,000 but we don’t know how this would be distributed across the regions so we have entered the value in the total line. If we now select the roadside tab again and press analyse the system will calculate the cost per thousand contacts per region as shown below.
CAFAS has distributed the 2,000,000 proportionally by the number of panels per region. The cost per thousand contacts is showing the cost in any currency per thousand visibility-adjusted contacts CPT (total VAC Contacts) in that region.

**NOTE**

CAFAS also offers the option of calculating cost per thousand people covered this can be selected using the options menu and then pressing the analyse button. The column heading and calculation will change to CPT (P). This will be more expensive than CPT (C) as the frequency element is removed form the cost basis.

Toolbar > Options > Select CPT (C) or CPT (P)

CAFAS has the ability to reduce the number of columns to make the screen more readable, see the :

Toolbar > Options > Reduce columns, this removes the average Flow/OTS/VAC information columns.
Cost feeds included in the data feed in report

It is possible to switch between “Cost from Network File” and “Costs from CPT Screen” via the “Options” menu on the “Campaign or Package Analysis” screen. Buses CPT will always automatically be calculated from the CPT screen.

To input the cost of a panel on a line by line basis for inclusion in the CPT calculations, the file format should be as below. Please note this is different from the format used for site lists.

<table>
<thead>
<tr>
<th>Company Code</th>
<th>(3 Characters (JCD/CLC))</th>
</tr>
</thead>
<tbody>
<tr>
<td>District Code</td>
<td>(4 Numerals (Current codes, 0180 etc.,)</td>
</tr>
<tr>
<td>Location Code</td>
<td>(4 Characters/Numeral (zero fill, but allows sub-district location)</td>
</tr>
<tr>
<td>Site Number</td>
<td>(X Characters)</td>
</tr>
<tr>
<td>Panel Number</td>
<td>(X Characters)</td>
</tr>
<tr>
<td>Panel Size</td>
<td>(X characters)</td>
</tr>
<tr>
<td>Address</td>
<td>(50 characters)</td>
</tr>
<tr>
<td>In charge date</td>
<td>(YYMMDD)</td>
</tr>
<tr>
<td>Out Charge date</td>
<td>(YYMMDD)</td>
</tr>
<tr>
<td>Cost</td>
<td>(00000.00)</td>
</tr>
</tbody>
</table>
Campaign Planner

The campaign planner is designed to estimate coverage for X number of panels, using the Flow/OTS/VAC averages for the selected size, region, month and Social group. Effectively planning using an “average” panel of any selected size. This planning function is available for all panel environments, and in addition, if mixtures of environments are selected, a combination cover is calculated.

You can hide the non-dynamic average per week columns via “reduced columns” on the options menu. On Entry the program has no chosen criteria. To calculate an estimate, the following process must be undertaken. Defaults are 100 panels and 7 days.

1. Select a size from the pull-down box. (the system will then calculate the required averages for that size.
2. Enter the number of panels required, either in the Panels box, or click in the grid and enter the number of panels required in each Region.
3. Select Distribute by Adult population or by Share of Voice  (see later in this section for explanation)
4. Press the analyse button.

The other options, time, media owner, month and social group can be selected and changed at any time. Period default is 7 days, simply changed by entering a new period in the Days box.

Campaign planner – Further Notes

This function is designed as a method of estimating the coverage you should achieve by using different mixtures of size, time, environment or area. It is NOT a method of measuring the actual coverage a campaign will achieve. This actual measurement is done in the campaign analysis screen.
The campaign planner uses average area and poster size Flows, OTS and VAC. These columns can be shown or hidden in CAFAS via the options menu (see below). It may not be possible for you to buy to the average, you may get higher or lower figures in an actual network.

The campaign planner uses distribution averages based on typical networks that were available for analysis. Any actual campaign may have very different distribution patterns from these averages.

The campaign planner is NOT an optimiser; it simply uses average posters.

Campaign planner – Roadside

In the example above, we have selected the size required as a Eurosize, and we have used the default period – 7 days, the default Month – May, default is always the current month, and the default number of panels, 500.

As a starting point on the spread of the panels regionally we have chosen to distribute the panels proportionally to the Adult population. For example, if a particular region had 20% of the total country population, the system will allocate 20% of the posters to that region.

Note: this may NOT be the optimum spread of panels, it is just a planning starting point. The alternate starting point may to distribute the panels by Share of voice, the second tick box.
In the example above the starting point on the spread of the panels is share of voice. Panels are distributed in relationship to where they exist, so if 32% of Eurosizes are in Oslo, the system will place 32% of the campaign size in Oslo, thus equating to an equally share of voice in each region for the chosen size.

The effect of distributing panels by either method can be seen in the previous examples.

Once we have a basic configuration, we can then adjust each region to any number of posters we require, so in the case above we could click in the Oslo region panels box and change the number of panels from 163 to 150 shown below.

The system will then calculate the relevant average panel scores and apply these in the coverage models, so calculating the estimated VAC cover percentage and VAC Average Frequency. It should be noted that the system will not report in areas where the campaign sheetage is very small as the estimate would not be statistically robust.
In brief, the remaining columns in the grid display the following numbers: (see Poster and Cafas terminology for more detailed descriptions)

<table>
<thead>
<tr>
<th><strong>Panels</strong></th>
<th>The selected or entered number of panels by model region.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Av Flow</strong></td>
<td>Shows the average traffic Flow in adults 12+, for the indicated region and selected size per week. This number can be checked by opening the digest &gt; Flow by media owner screen. The average Flow per week will match that displayed in the campaign planner.</td>
</tr>
<tr>
<td><strong>Av OTS</strong></td>
<td>Shows the average directionally adjusted Error! Reference source not found. in adults per week, for the indicated region and size.</td>
</tr>
<tr>
<td><strong>Av VAC</strong></td>
<td>Shows the average number of visibility adjusted contacts VAC, in adults per week, for the indicated region and size.</td>
</tr>
<tr>
<td><strong>VAC cover%</strong></td>
<td>Shows the estimated VAC coverage which is the proportion of the selected audience by region that will have at least one contact with the campaign of X panels over the time period selected, in the example above this is 7 days.</td>
</tr>
</tbody>
</table>
| **POP Cover** | Shows the Population covered as the number of the selected social group in that region, that will have at least one contact with the campaign.  

\[(\text{VAC cover\% } \times \text{Total region social group population} = \text{POP cover})\] |
| **VA Contacts** | Shows the total number of Visibility adjusted contacts (VAC) that the selected social group will have with the campaign. |
| **VA Av Freq** | Shows the Visibility adjusted average frequency which is the average number of visibility adjusted contacts (VAC) that the covered population will have with the campaign over the selected number of days. |
| **GRP** | Poster equivalent “ratings” for the campaign. See section in cafas terminology on GRP |
| **CPT** | Poster cost per thousand, either contacts or covered. See section on Cost Per Thousand |

You can hide the non-dynamic columns average flow per week/average OTS per week/average VAC per week via “reduced columns” on the options menu.
Campaign planner – Mixing Sizes

The campaign planner allows the mixing of sizes within a region. There is a secondary tab next to the “Results” tab, which can be selected to turn on the feature.

On basic usage, a single size is selected as shown below:

In the example below we have selected the “Size Mix” tab and it can be seen that the original sizes and distribution is maintained as the start point. From here we can enter the number of panels of any additional sizes. If they are to be distributed in the same manner as the initial panels the total quantity can be entered in the relevant total line. Below we have entered 50 additional CityBacklite in Oslo to our original 150 Eurosise as in this example the additional panels are only required in Oslo.

We can now return to the roadside “Results” tab:
On pressing the analysis button, the 50 additional CityBacklite are added to the campaign mix. The weighted total OTS

Where a particular size mix is not possible, either through ownership or presence of panels of that size in a particular region, then the size mix cell concerned will be coloured red. This warning in colour will also be transferred by default to the “Results” grid.

The same method of mixing panels can be used in all environments and these panel formats in turn can be combined via the combined cover tab.

Distribution in the campaign planner

In the Campaign Planner, when you enter a number of panels in the total box this is distributed evenly amongst the areas. This works in a similar fashion to other “total” figures when entered on the “spreadsheet” on screen.

Distribute the total figure on the Size Mix tab according to your choice of share of voice or by adult population. Enter the total figure and select the option required, or select the option required and enter the total figure. Any number entered apart from on the total line will turn off the distribute feature as you would have changed the numbers on the screen and they would not match. You can turn this feature on and off as required.
Campaign planner – Travel

Using the same spreadsheet grid as shown above in “Roadside”, if we now select the “Travel” tab, we can plan a mixture of panels by region. In this instance we have selected 200 panels in the Travel environment.

Panels are classified into environments depending on their main criteria. So that panels in Railway stations, or Metro stations or in other environments where the main object of the passing audience is to “travel” are included in this category.

Each category or environment is analysed and summarised by size and coverage region (Oslo region etc). See earlier references to the Digest screens pp Digest or Summary of stock.

In many ways it is similar in coverage and frequency terms to “roadside”, in the travel environment the passing audience is regular or on a daily basis, but for a more restricted audience who travel that route. So it is a high frequency medium.

In the above example we have chosen 200 Eurosize, distributed by Share of Voice initially, then we have entered 30 panels in the “Rest of Country” box. The system will calculate the required factors to predict a likely coverage and frequency level, given similar “universe average” posters are bought in the real campaign.

It should be noted that in the “Rest of Country” row 6 of the grid, the panel numbers allocated cannot be bought as they do not exist in this quantity, and are hence shown in red.
Campaign planner – Retail

Using the same spreadsheet grid as shown above in “Roadside” and “Travel”, if we now select the “Retail” tab, we can plan a mixture of panels. In this instance we have selected the default 200 panels in the Retail environment.

It should be noted that the “Retail” environment has a different coverage and frequency profile to the travelling environments of “Roadside or Travel”.

For example, achieving 11 million contacts per week in Roadside, a high reach can be achieved because the “environment” is open to everyone, people travel the same routes day after day and most people leave home at least once per week. In retail the same level of VAC contacts will translate into lower coverage but higher frequency, as there is a limited audience who visit these retail locations.
Campaign planner – Combined

We can now mix 551 panels on the “Roadside” tab and our 200 Retail and 230 Travel and look at the projected combined cover.

It should be noted that the coverage and frequency produced in each environment, Roadside/Transport/Retail are not simply additive as the audience will have a probability of seeing either or both formats.

For example, if we had a mixed roadside and retail campaign, the system will display the coverage solely for Retail on the Retail tab and solely for the roadside element on the Roadside tab. The people who are covered in the retail environment must also travel down the roads to get to the retail centres and so will also be covered by the roadside element. The combined coverage is shown on the combined tab.

The system on the “combined cover” tab calculates the coverage and frequency overlap between the various selected coverage environments Roadside/Travel/Retail/Transport dependent on the weight of posters in each environment and displays the total or combined non-overlap coverage and frequency.

Cost Per Thousand

See section in Cost Per Thousand campaign analysis.
Campaign planner – Saving the Plan

The campaign planner allows the saving of the plan details so that it can be referenced at a later date.

Once the plan has been finalised, use the option File > Save

You will then be prompted for the location to save the plan. You can create a directory and view your machine file structure.

The plan is save as a text file in the directory chosen.
Any saved plan can be opened again and re-loaded into the planner by using the File>Open option when a blank Campaign Planner window has been selected.

A list of the most recently accessed plans is also displayed.
Other Media Research

All of the main advertising media, TV, Radio and Press have research that offers the clients an estimate of the coverage and frequency of a campaign. This estimate is a major factor in allowing a client to decide on the “value” of that particular medium for his or her advertising. It is not the only factor, price, availability, prominence and share of voice also come into the equation, but these are more subjective measures.

Most of this other media research has been in place for many years and so outdoor as a new entrant must be proven to be better and more up-to-date methodologically so that it can take its place along side the other media research.

Detailed below is a brief description of the typical research methodologies of other media. Many of the terms used are directly comparable to those in the Cafas system, it also being noted that the term “reach and frequency” is the same as “coverage and frequency”

TV reach and frequency

A TV campaign is a series of “spots” or advertisement breaks. A typical campaign may be 50 to 100 “spots” run over a period of several weeks. The chosen spots will not all be in the peak hours of weekday evenings. The “spots” will be distributed across the schedule and may even be across several channels. In this way hard to reach people, such as night-workers, or students may also be covered by the campaign.

To measure the coverage and frequency of a campaign the TV stations need to know who is watching each channel at any one time. Obviously they cannot measure everyone, so they choose a representative sample of the populations, say 1000 people, and ask them for their viewing to be electronically measured.

They provided small handsets to the chosen sample, like a TV remote control, and each person in the family will have their own button on it. The handset is then linked to the television so that the current playing channel can be detected. Then as people come and go from the TV room they push their button indicating they are in the room or have exited and gone elsewhere. The data being sent back to a central computer by phone every night.

There are some obvious flaws in this research methodology and it is worth listing them, as they can be relevant in arguments on the pro’s and con’s of outdoor research.

1. The sample sizes that can be measured are relatively small, 1000 people or so, because of the expense of the continual monitoring required.
2. The small sample sizes mean that programs aired outside of the “peak viewing” times may only have 5 or 10 people watching from the sample. This introduces very large margins of error, if one person goes to bed the measured audience can drop by 20%.
3. The people in the room may not all be watching the television, they may be reading or talking or taking part in some other activity that distracts their attention.
Effectively this means they are not measuring opportunity to see (OTS) but are only measuring “presence in the room”.

4. The reach of a campaign can only be measured after it has run as TV viewing is reliant on “content” and it is much harder to predict what channel people will be watching at 7.00pm a week or a month in the future.

Radio reach and frequency

In Radio the most common methodology is a weekly 15-minute diary. A representative sample of a 1000 or more people are chosen and issued with either electronic or paper diaries. They then have to complete the diary at the end of each day to say which radio stations they were listening to during each 15-minute period.

Like TV research there are some obvious flaws in this research methodology and it is worth listing them for the same reasons.

1. The overall sample size makes it difficult to measure listening on local and minority radio stations, where <5% are listening.
2. The diary task is heavy in time for respondents, and it is expected they will automatically fill in the stations that are easily remembered. So light-listening stations will be under reported and heavy-listening stations over reported.
3. The total listening time will always be over reported as the smallest block is 15-minutes even if the listener only has the radio turned on for 5 minutes to catch the news or weather forecast.
4. New technology is being tested, recording watches, worn by respondents, pick up the audible stations. These are then matched to the “schedule”. This should be a more reliable methodology, if the respondents wear the watches and other background noise can be filtered out.

Press or Magazine reach and frequency

In general the daily or weekly sales figures for each “title” are used as a guide on the reach and frequency of a campaign. Some “titles” may claim extra secondary readership because perhaps the whole family will read a TV listing magazine or Weekend newspaper.

Because the ownership of the press is diverse, and sales figures are commercially sensitive, often an industry research body or independent market research company is employed to “audit” the returned figures.

Flaws in Press research methodology.

1. Readership is based on the assumption that each person who buys the paper or magazine “reads” every page, so an OTS based on this is “true” only for the front page.
2. The OTS of inside pages cannot be measured and can vary a great deal depending on “content” of opposing pages and size of title.
3. Proximity to other advertisements and “inappropriate content” can affect the message.
4. Readership of supplements (like free listing magazines on a Sunday) is based on the sales figures for the main “title”.

Good points in Press research
1. Each title has a very “tight” social demographic readership. For example, 15 – 19 year old Women have their own magazines, as do other social groups.
2. Local Press can be used for small-scale campaigns for local products.

Outdoor reach and frequency

We can now compare the reach and frequency generated in the cafas system to those of the other mediums.

For:
Outdoor is a “broadcast” medium, more like TV and radio than press. This means that the whole population can see the message, so the potential for coverage is much higher.

Against:
Outdoor has limited variation in social demographics, it is impossible to target “professional men” without also picking up all other social demographics to the same extent.

For:
Outdoor is a high frequency medium. Because of the repetitive nature of most journeys, to work or school every day, an outdoor campaign will provide a contact almost every day. TV, Radio and Press do not have such high frequencies.

Against:
The other medium can deliver more detail, as they may be seen only once but the contact time is longer.

For:
The message in Outdoor advertisements are not normally influenced by close proximity “content”, like TV, Radio and Press.

Against:
The message in Outdoor must be very simple, Product, Strapline and Brand, there is no room and it is not possible to read detailed offers and complicated messages.

For:
Outdoor coverage and frequency is very predictable into the future, because journeys and general mobility of a population are very reliable. So you can plan a campaign in 6 months time and be very confident that the estimated coverage and frequency will be delivered.

Against:
It has relatively long lead times, all the posters must be printed and pasted up, I can’t use it to advertise a product next week.
For:

Because outdoor is a “broadcast” medium, it is easier to reach some target groups, for instance if selling a new women's magazine, that covered all age groups, then using outdoor is a relatively easy method. The other media alternatives are much more complicated.

Finally, additional insights into the consumption of these and other media are contained in an annual study called **Target Group Index** which also measures the consumption of products and services across the majority of industry categories (from who drinks coca cola to who uses each of the mobile phone networks etc etc). Media consumption data can be cross-referenced with product consumption data to assist in the targeting of advertising campaigns.